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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for 
technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 
and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items 
are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2001-2014 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel® and Itanium® are trademarks of Intel Corporation in the U.S. and other countries.

Microsoft®, Windows®‚ Windows® XP are U.S. registered trademarks of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Support

Visit the HP Software Support Online website at:

http://www.hp.com/go/hpsoftwaresupport 

This website provides contact information and details about the products, services, and support that HP Software offers. 

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access 
interactive technical support tools needed to manage your business. As a valued support customer, you can benefit by 
using the support website to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract. To register for an HP Passport ID, go to:
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http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

Support Matrices

For complete support and compatibility information, see the support matrix for the relevant product release. All support 
matrices and product manuals are available here on the HP Software Support Online website:

http://h20230.www2.hp.com/sc/support_matrices.jsp

You can also download the HP Server Automation Support and Compatibility Matrix for this release from the HP Software 
Support Online Product Manuals website:

http://h20230.www2.hp.com/selfsolve/manuals

Documentation Updates

All the latest Server Automation product documentation for this release is available from the SA Documentation Library:

http://support.openview.hp.com/selfsolve/document/KM00417675/binary/SA_10_docLibrary.html

Use the SA Documentation Library to access any of the guides, release notes, support matrices, and white papers relevant 
to this release or to download the full documentation set as a bundle. The SA Documentation Library is updated in each 
release and whenever the release notes are updated or a new white paper is introduced.

How to Find Information Resources

You can access the information resources for Server Automation using any of the following methods:

Method 1: Access the latest individual documents by title and version with the new SA Documentation Library

Method 2: Use the complete documentation set in a local directory with All Manuals Downloads

Method 3: Search for any HP product document in any supported release on the HP Software Documentation Portal

To access individual documents:

1 Go to the SA 10.x Documentation Library: 

http://support.openview.hp.com/selfsolve/document/KM00417675/binary/SA_10_docLibrary.html  

2 Log in using your HP Passport credentials.

3 Locate the document title and version that you want, and then click go.

To use the complete documentation set in a local directory:

1 To download the complete documentation set to a local directory:

a Go to the SA Documentation Library: 

http://support.openview.hp.com/selfsolve/document/KM00417675/binary/
SA_10_docLibrary.html  

b Log in using your HP Passport credentials.

c Locate the All Manuals Download title for the SA 10.1 version.

d Click the go link to download the ZIP file to a local directory.
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e Unzip the file.

2 To locate a document in the local directory, use the Documentation Catalog (docCatalog.html), which provides an 
indexed portal to the downloaded documents in your local directory.

3 To search for a keyword across all documents in the documentation set:

a Open any PDF document in the local directory.

b Select Edit > Advanced Search (or Shift+Ctrl_F).

c Select the All PDF Documents option and browse for the local directory.

d Enter your keyword and click Search.

To find additional documents on the HP Software Documentation Portal:

Go to the HP Software Documentation Portal:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, click the New users - 
please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP 
sales representative for details. See Documentation Change Notes for a list of any revisions.

Product Editions

There are two editions of Server Automation:

• Server Automation (SA) is the Ultimate Edition of Server Automation. For information about Server Automation, see the 
SA Release Notes and the SA User Guide: Server Automation.

• Server Automation Virtual Appliance (SAVA) is the Standard Edition of Server Automation. For more information about 
what SAVA includes, see the SAVA Release Notes and the SAVA at a Glance Guide. 
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1 Server Automation Reports Overview
This document gives a general overview of the Server Automation (SA) reports. There are two venues for 
SA reports, SA Client reports that are available in the SA Client, and Automation Insight (AI) reports.

See chapter discusses SA Client Reports embedded in the SA Client.

For information about viewing, launching, and scheduling reports, and building custom reports, see the 
Reports section of the HP Automation Insight User Guide.

For specific information about  HP Automation Insight reports and universes, see the solution pack user 
guides that are provided with each solution pack available for download on HPLN (at http://
www.hp.com/go/livenetwork).

IMPORTANT: LNc will not list, download, preview, or import content if you do not have the proper 
products specified! See the Live Network connector Users Guide on the HP Live Network for instructions 
on enabling products. 

• Subscribe to the relevant reports streams for your version of SA and the reports you wish to run. To 
download the report streams:

— Go to the HP Live Network and click the Live Network connector link.

— Download the LNc Users guide for instructions on using the HP Live Network and information 
about the correct report streams. 

— Once the LNc has been configured for your specific product(s), you can also see a list of available 
streams via:

live-network-connector list-streams

Additional information may be available on the individual streams by using the “describe” 
command. This information may provide a long text description and a URL for where to locate 
additional information on the specified Stream/content.

URLs:

• HP Live Network URL = http://www.hp.com/go/livenetwork.

• The HP documentation portal URL = http://h20230.www2.hp.com/selfsolve/manuals

For additional information about how to access and run these reports, see the online help in the 
respective Automation Insight tool.

SA Client Reports Embedded in SA Client

SA Client reports provide real-time information about managed servers, virtual servers, network devices, 
and user and security permissions in your environment. They are parameterized and actionable—which 
means that you can perform appropriate actions on objects, such as a policy or an audit, within the report. 
These reports are also exportable to your local file system (as .html, .pdf, or .xls files) to facilitate use 
within your organization.
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See Chapter 2, “SA Client Reports.”

HP Automation Insight Reports for SA

HP Automation Insight (AI) is an HP product that leverages HP Vertica analytics database technology and 
provides a complete set of ETL tools, dimensional data model, reports, dashboards, and analytics 
systems and content for the HP suite of automation tools. 

For information about viewing, launching, and scheduling reports, and building custom reports, see the 
HP Automation Insight User Guide.

For specific information about  HP Automation Insight reports and universes, see the solution pack user 
guides that are provided with each solution pack available for download on HPLN.
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2 SA Client Reports
SA Client reports provide comprehensive, real-time information about managed servers, virtual servers, 
network devices, and user and security permissions in your environment. These parameterized reports 
are presented in graphical and tabular format, and are actionable—which means that you can perform 
appropriate actions on objects, such as a policy or an audit, within the report. These reports are also 
exportable to your local file system (as .html, .pdf, or .xls files) to facilitate use within your organization.

This section contains information about the types of SA Client reports, how to modify report parameters, 
how to run the reports, and how to perform actions in the report results.

Additional reporting for SA Client features is available in the HP Automation Insight Product. 

For information about viewing, launching, and scheduling reports, and building custom reports, see the 
HP Automation Insight User Guide.

For specific information about  HP Automation Insight reports and universes, see the solution pack user 
guides that are provided with each solution pack available for download on HPLN.

In this section:

• Reports Features

• HP Server Automation Client Reports

• User Permissions for Reports

• Launching the Reports Feature

• Reports Display

• Running a Report

• Report Results

Reports Features

SA Client Reports enable you to perform enterprise health assessments by providing the following 
features:

• Actionable reports that enable you to take the appropriate action on objects within the reports. For 
example, in the list view of a compliance report, you can select a server and open a Remote Terminal 
or Server Explorer to browse it, perform an audit, create a snapshot, create a package, and so on.

• A single entry point in the SA Client Dashboard for all reports.

• Reports that are data-secured—controlled by the user’s permissions. You can view all objects that 
you have read permissions for. You can perform actions on objects that you have write permissions 
for.

• Reports that are exportable to .html, .pdf, and .xls formats. You can export reports to your local file 
system for use within your organization.
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HP Server Automation Client Reports

The following table lists the SA Client Reports by report folders.  

Additional reporting for SA Client features is available in the HP Automation Insight (AI) product. For 
information about viewing, launching, and scheduling reports, and building custom reports, see the 
HP Automation Insight User Guide.

table 1 SA Client Reports 

Report Folder Report Title

Server Reports • Servers by Customer

• Servers by Facility

• Servers by Manufacturer

• Servers by Model

• Servers by Operating System

• Servers by Use

Virtualization 
Reports

• Solaris 10

— Virtual Servers by Hypervisors (zones only)

— Resource Allocation by Hypervisors (zones only)

User and 
Security 
Reports

• Client and Feature Permissions

• Customer/Facility Permissions and Device Group Permission Overrides

• User Groups Memberships

• User Login

• Administrator Actions

• Users and Authorizations, By User Group

• Users and Authorizations, By Individual User Group

• Administrator Customer Groups

• Server Permissions, By User

• Server Permissions, By Server

• OGFS Permissions, By User

• OGFS Permissions, By Server

Network 
Reports

• Connections by Network Device

• Connections by Server

• Duplex Compliance (All Servers)

• Duplex Compliance by Customer

• Duplex Compliance by Facility

See also, “Network Reports” in the SA Integration Guide
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For specific information about  HP Automation Insight reports and universes, see the solution pack user 
guides that are provided with each solution pack available for download on HPLN. 

User Permissions for Reports

Reports are controlled by the user’s permissions. You can view all objects that you have read permissions 
for, and you can perform actions on objects that you have write permissions for.

To view or run a network report, SA/NA integration must be configured. See the SA Integration Guide.

To view or run a user and security report, system administrator permissions are required.

Launching the Reports Feature

To launch the Reports feature, perform one of the following steps:

• From the View menu, select Reports > Dashboard.

• From the View menu, select Reports > Reports.

• From the navigation pane, select Reports.

Reports Display

In the SA Client reports window consists of a search pane, report parameters, report folders, and other 
filtering tools.

In this section:

• Search Pane

• Report Folders
SA Client Reports 11



• Report Parameters

figure 1 The Reports Feature Display 

Search Pane

All tab views have a search pane that allow you to search for information in the SA Client by selecting a 
component category and entering a keyword in the search text field. The results appear in a configurable 
list in the contents pane with an option to specify additional filter criteria. For more information, see the 
SA Users Guide: Server Automation

Report Folders
Reports are organized into folders according to regulatory or IT best practice standards. 

• Server Reports: This folder contains reports about servers by customer, facility, manufacturer, 
model, operating system, and server usage.

• Virtualization Reports: This subfolder contains reports about virtual servers and resource allocation 
by technology and by hypervisor.

• Network Reports: This folder contains reports about connections and duplex compliance for network 
devices and servers. You must have NA installed to see this folder.

• User and Security Reports: This folder contains reports about client and feature permissions; 
customer, facility, and device group permissions; and user group memberships. You must have 
system administrator permissions to see this folder.
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The following figure illustrates how the Report folders appear in the navigation pane, including the 
reports listed in each folder.

figure 2 Report Folders 

Report Parameters
Many reports require input parameters in order to be run. For these reports, you can run the report with 
its default parameter values or modify the parameter values. If you want to run a report that includes or 
excludes certain servers, customers, or hardware models, you need to specify this criteria in the report 
parameters. See Running a Report on page 13.

Running and Modifying Reports

In this section:

• Running a Report

• Modifying Report Parameters

Running a Report

To run a report, perform the following steps:

1 From the navigation pane, select Reports.
SA Client Reports 13



2 Expand the Reports folder and then expand the Server Reports and Virtualization Reports. 

3 Select one of the virtualization report listed in the folder.

4 If there are no report parameters in the Content pane, click Run.

5 If there are report parameters in the Content pane, you can either use the default parameters or 
change them:

• To use the default report parameters, click Run to run the report. The report results appear in the 
contents pane. See Report Results on page 14.

• To change the report parameters, see Modifying Report Parameters on page 14.

Modifying Report Parameters

You can modify the default parameters and run a report that includes certain servers, customers, or 
hardware models.

To modify the default parameters:

1 In the drop-down list for (the Server, Customer, Model, and so on), select Contains, Equals, Begins 
With, or Ends With.

2 (Optional) Select the ellipsis button to open the Select Values window.

3 In the Select Values window, select a value in the Available or Selected pane and then use the 
directional buttons to include it in or exclude it from your search criteria.

4 Click OK to save your changes.

5 Click Run to run the report. The report results appear in the contents pane. See Report Results on 
page 14.

If data cannot be found to run the report, a “No records to display!” error displays. See also Report Results 
Restrictions on page 17.

Report Results
Report results initially appear in a graphical or list view. The graphical report is an overview of available 
data for this report displayed in a pie chart or in a bar graph. You can drill down for more detail in the chart 
or graph by clicking on any of the sections or bars. For example, you can drill down to individual servers 
that appear in a report and get detailed information about them.

In this section:

• Viewing a Graphical Report

• Viewing a List Report

• Exporting a Report

• Printing a Report

• Report Results Restrictions
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Viewing a Graphical Report
A graphical report is a pie chart.

figure 3 Pie Chart    

Click on a section of the chart to drill down for more details or to perform an action. You can also click on 
the “Show all <number> servers” link to display a list of servers. 

Click on a segment to 
view details of the 
segment in a list 
SA Client Reports 15



Viewing a List Report

A list report is a tabular display of information. Double-click on a row in the list, such as a server, audit, or 
policy, for more detail or to perform an action. See Figure 4 for an example.

figure 4 List Report 

Exporting a Report

You can export a report to your local file system for use in other applications or to distribute as an 
attachment in an email. The type of report determines which export file formats are available:

• Graphical reports (pie or bar charts) can be exported to .html or .pdf format. 

• List reports can be exported to .html, .pdf, or .xls format.

When you export a report in the SA Client, the time that you will see marked on the exported report will be 
the time when the report was exported, not the time when the report was generated.

To export a report:

1 From the report, click Export to open the Save window.

2 In the Save in field, enter a location that identifies where you want to save the file to, or select from 
the drop-down list.

3 Enter a file name.

4 Select the file type.

5 Click Save.
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Printing a Report

To print a report:

1 From the report, click Print to open the Print window.

2 Use the default print options or modify them, and then click OK.

Report Results Restrictions

The following reports have a limit of 2000 “items” that can be displayed in their results:

• Server Permissions By Server

• Server Permissions By User

• OGFS Permissions By Server

• OGFS Permissions By User

In these reports, if the results reach 2000, the report will stop, because depending on the specified search 
parameters, they can yield thousands of results and slow performance of the SA core.

For example, the Server Report by User will run successfully if you specify 10 users and 200 servers in the 
search parameters, but will not run if you specify 10 users and 201 servers.

To avoid this problem, either modify your search parameters to yield less results, or break the report 
query into smaller searches and run as many smaller reports as you need to achieve your results. 
SA Client Reports 17
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